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“WINe Cellar” Install: 

 

 - Files:  All files will be copied to your hard drive if they do not exist or if the existing version is earlier. 

   There are two types of files: system files and application files (of the software). 

 

  Systems: they will be copied to the subdirectory "System" or "System32" or "Syswow64" of Windows. These are 

only the original files made by Microsoft or with Microsoft tools. 

 

  Applications: a directory name will be required during installation. 

 

 - Launch of the installation: 

 

  After turning on your computer (yes!) and Windows started, place the CD ROM in the drive. If the installer does not 

start automatically, start Windows Explorer, select the drive containing the CD Rom and after viewing the content, double click the 

file "SETUP.EXE". Another possibility: use the sub menu "Run" from the File menu or Start menu in Windows and type "D: \ 

SETUP" - if the CD Rom is in drive 'D' - followed by "Enter ". Now you have just to answer questions and follow the instructions 

of the installer. 

  The installer adds entry in the Start menu to allow you to run the software, uninstall it and go to the website. 
 

 

“WINe Cellar” uninstall: 

 

 Windows 9x, NT, 2000, XP, Vista, 7, 8, 8.1 and 10: 

  Always use the uninstaller sub-menu created when you install the software by clicking "Start", "All Programs", "Wine 

Cellar" and "Uninstall Wine Cellar". It is more complete and faster than Windows - "Add / Delete Programs ". 

 

If you have created other files after installation, you must delete them from the directory as well as the repertory of “WINe Cellar”. 

For system files, you can accept their removal if you are sure not to need them. 
 

_______________________________________________________________________________________________________  

I



WINe Cellar User’s Guide 

 
First use of "WINe Cellar": 

 

At the first run of "WINe Cellar", a level control Windows installation is done and may ask you to install a "MDAC" most recent 

only on oldest Windows versions. It is mandatory. The "MDAC" is on the installation CD or can be downloaded from the address 

in the message. This file is a Microsoft product included in Windows since Xp.. 

 
 

WARRANTY:  

 

Total by exchange for the support, total for failure to complete operation. No for use accounting or business. 

 

If you encounter a problem (a real bug!), contact me and I will do what is needed to fix it and correct if necessary your data file. 

By cons no guarantee is given when an external action has taken place (virus, crash, accidental deletion of data ...) 

 

Being the first user of the program, I guarantee you the product tracking. I guarantee the other hand, I did not put any dangerous 

or destructive code, and the only protection consists of: encryption and register your name and address in the program. 

 

You can call me for any problems regarding the software, evening or weekend. This "Hot Line" is not limited as there is no 

exaggeration. Even if you are in a case not covered by warranty, you can contact me and I will help you with pleasure. 

 
Limitations:  

 

This software cannot be used on more than one station at the same time and by different persons unless payment of licenses. The 

licensee may install on multiple computers if he is the only user, or on a single station (the one of the owner) for multiple users. 

By station means PC or terminal, network installation is reserved for owners of multiple licenses. Only the backup or backup for 

security reasons is allowed. 

Any exemption must be confirmed in writing by the author, single owner of the software. 

 

______________________________________________________________________________________________________ 
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WINe Cellar Version 8 
 

 

Your personal sommelier. 
 

 Whether you are a connoisseur of fine wines or occasional consumer, you've always dreamed, to have a well supplied 

cellar. Can you ever be one of those happy owners of a cellar worthy of the great houses, which combines Sauternes, Saint Emilion, 

Pauillac, Beaune and Chablis...? Even if not yet the case, the software "Wine Cellar" will be of great help. This very French software 

allows you to manage efficiently inputs and outputs of bottles, knowing the composition and value of your cellar and when to 

consume wine. 

 

Discovery of “WINe Cellar” 

 This software is very easy to use and allows you to record your purchases of bottles to store them in your virtual cellar, 

view at any time the composition of your cellar, find the location of a bottle and its period of consumption, before having to descend 

 into the coveted place where the pale light often misleads us.  "Wine Cellar" will also allow you to print lists based on very 

specific criteria: vintages, wines, appellations, etc... You can also annotate a wine, record the purchase price and the output of a 

bottle to manage your consumption and even export your reports to a spreadsheet or to revise them in your way, either in the raw 

or formatted "XML" format. 

We will proceed to the constitution of your personal database, using an example quite subjective. You can of course apply this 

example to your wine cellar, replacing the bottles directly quoted by yours. 
 

 or if you have created a shortcut on the desktop  
 

Fig. 1 
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Launching “WINe Cellar”:   open the menu Start, (Program), WINe Cellar… (Fig. 1) 

 

 

 

 

In configuration network or if you set “Login” to start, you will get the following window (fig. 2). 

 With the reception of the software, you can use the following identifiers: 

  “Rey” password:  “reyrey” complete use 

  “Rey2” password:  (none) reading alone 

  “Admin” password:  (none) administrator (identifiers and passwords). 

 

 
 

Fig. 2 

 

A wait window reminding the software name and that of the licensee appears during the time of loading the database, long 

time before the Pentium, and after very brief. 

Finally appears the main menu of "WINe Cellar" (Fig. 3). 
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2



WINe Cellar User’s Guide 

 

 
Fig. 3 

 

Build your wine cellar 
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 "WINe Cellar" offers a sample database, entitled "Cavetest.MDB" you can already view or edit. It is more interesting to 

apply "WINe Cellar" in your own wine cellar. That's why you'll ignore this example. To manage your wine cellar you will have to 

create a new database by going clicking to the "New" command from the File menu (Fig. 4). 

 The window allowing you create your new database appears and waits you enter the name of your file in the box labeled 

“Filename“ Title your file "Macave.MDB"(or "My préférée.MDB WINe Cellar") and click "Save" (Fig. 5). 

A message asks if you want a pre-filled or empty file. File pre-filled with a number of countries, Soil (Terroir), Appellation, 

colors and containers. This file is still under development. 

 After you have been asked what currency ($ or €) you want to attach the amounts entered, for the empty file, the program 

will display the "Account" (Fig. 6), where you will enter details of the owner of the WINe Cellar. Later you can create other 

"accounts" to manage several Cellars in your file. 

 Automatically return to the main screen. Your file is currently completely empty (not for pre-filled file). We will have to 

record information about your good bottles. 

Automatically return to the main screen. Your file is currently completely empty (not for pre-filled file). We will have to 

record information about your good bottles. 

 

 
Fig. 4 
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fig. 5 

 
 For each of the operations that will be stated here, you will have the choice between two modes of access. Either click on 

the corresponding "Button" in the main screen or you will unroll the "Menu" and call the desired "command", always from the main 

screen. In order to leave you this choice, the two modes of access will be indicated to you each time. 

______________________________________________________________________________________________________ 
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Fig. 6 

 

 
Fig. 7 

 

 To save your bottles, here's how: click "Wine Inputs" or scroll down the menu "Data" and select the "Wine Input" (Fig. 7 

and 8). 

 The window to enter "Wine" bottles appears (Fig. 9). 
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Fig. 8 

 

You will fill it. The first box asks for the Wine Country. Then the second the Soil Wine. This is Land at large. Then the Appellation. 

Then the Name of your wine. Every time you enter a new reference, a screen prompts you to confirm your entry. Say the first wine 

you are recording is a Sauternes, Chateau Rieussec 1990. The country will be "France, the Soil will be" Bordeaux "appellation is" 

Sauternes ", the selected color will be" White "or" Sweet White ". After entering the country or the Soil and you type the key "Tab" 

to go to the next area, of course if the value does not exist, following message will appear: (Fig. 10). You will need to confirm your 

entry and then another message prompts you to enter an abbreviated language optional (Fig. 11) if the option was selected in the 

settings ("Options"). Same principle for color (Fig. 12) 
 

Just click on "Yes" to confirm the new Country or Soil will be available later in the dropdown list. You will not have to reenter this 

Country or Soil when you need it. Just select it from the list. Useful, right? This rule also applies to all areas along with a small 

down arrow. Simply click on the arrow to expand the list and select the desired word or theme. 
 

 Third area to be filled: Appellation. Here we indicate the region of origin: here the region is "Sauternes". With the 

confirmation of entry and short text where appropriate (Fig. 12, 13). 
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Fig. 9 

 

Field color will be" White "or" Sweet White ". 
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Field "Title" awaits information such as: Domain, Château Clos, etc.. It may be that a wine does not have a title, select or 

enter a "." (Period). Here the title is "Château". 

Field "Article" allows, if necessary, by adding "d'", "du", "la" ... which often abound between the title and name, which make 

difficult selections and sorting in a database. In this area, they annoy you more. If an item has been entered by mistake, select the 

first in the list is blank (spaces) to erase it. 

Field "Wine" receives the name of your wine. Here, the name is "Rieussec". Confirming and abbreviated wording possible. 

 

  
Fig. 10                                                                                       Fig. 11  

 

   
Fig. 12      Fig. 13 
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Fig. 14  

 

 Field "Supplier" allows you to select or enter a supplier. If you enter a new supplier, an additional menu will allow you to 

enter all information (optional) on the supplier (Fig. 15). 
 

 Field "container" is used to enter the type of container for your wine. They can be multiple: bottles, magnums, clavelin 

cubitainer, drum, etc.. You can also enter the amount in cl. For your information, a bottle typically contains 75 cl of precious nectar. 

Clavelin is to receive the famous yellow wine from Château Chalon (Jura) contains 65 cl. It is true however that it is an exception 

... appreciated by connoisseurs. For your "Sauternes" it is 75 cl. Confirming and text abbreviated (if any). 
 

The "vintage year" refers to the year of harvest. It may be a few bottles in your wine cellar are not vintage. In this case enter 

a period "." instead of the year. Here you can enter "1990". 
 

 Field "Quantity" allows you to enter the number of bottles Sauternes Chateau Rieussec 90 of your wine cellar. You have 

three, you paid € 50 each. Enter this amount in the "Purchase Price". This field is not mandatory, but if you fill in, it will help you 

evaluate the value of your wine cellar. The currency code is the one registered for the owner of wine cellar. 
 

Field "Classification" allows you to specify the classification of wine or its medals, which is normally indicated on the bottle. 

In this case, château Rieussec is classified as "Premier Cru Classé 1855" - except errors. If this classification does not exist, you 

will have to confirm its creation (Fig. 17). 
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Fig. 15 
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Fig. 16 

 
Fig. 17 
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 Fig. 18 

 

The "Storage" allows you to specify the location, rack that will host your bottle. This will avoid the search indefinitely when 

you decide to drink. Again, entering this area is not mandatory unless you have opted for graphic management of your wine cellar 

even then you can store it later. 

_______________________________________________________________________________________________________ 
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Field "Purchase Date" pre populated with the current date, you can specify a date which will be used by the commands "Lists 

..." to delimit the extractions movements through time. 

 

 The last box allows you to specify the period of consumption stimulated, either by producer or by wine shop or decided 

by yourself. This field is not mandatory and remains highly subjective. It also appeals to some wine culture. Also, purists will 

they want to excuse me for any misjudgments in the example presented (Fig. 17). 

 

Four buttons at the bottom of the window allow you:  

 - To annotate a wine by writing a text of appreciation, an anecdote, 

 - To record a label (scanned, photographed, copied or drawn) 

 - To save the input in your base and go to the second recording, 

 - To close the window without saving and return to the main menu. 

 
 To practice, enter your second wine: it's a case of  6 bottles of Beaune Rouge, Clos des Mouches 1992, bought € 300 (the 

box!) then € 50 the unit that you choose to store in "Test A" line "P", column "3" and following . To "store" wine use test file 

(cavetest.mdb) otherwise you will have to create storage (see page 34 and following) or answer "no" to the request for storage or 

change the option. The result is shown in Figure 19. You can continue to store all your wines. When are finished, click "Close".  

 

 

 

Wine tasting notes: 

 
This screen appears after clicking "Sheet Tasting" menu "Input". The lines "Nuance" and "Sparkling" depend on the 

category of wine. Print a blank form (without selection or with incomplete selection) to see details. When the selection is complete, 

if data has already been entered, it appears and can be modified. Printing is done on an A4 sheet (fulfilled).For boxes "Options" (a 

circle), one choice may be made by line. For check boxes (square), there are multiple possibilities for a title. 
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Fig. 19 
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Fig. 20 
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The labels used for the radio buttons or check boxes can be changed in the file "English.lang" in sections [Fcave21] and 

[Fcave42]. For these labels, the two sections must remain the same. This file is located in the WINe Cellar directory and in case of 

problems (loss, mishandling ...) you can always download it but before you edit it, do not forget to save it.  

 

Do not forget that the boxes are fixed relative to the window and that their value will not follow the movement of label 

and especially that any change can affect what you have already entered. 

 

To delete a selection in “Problems” line, click on “Problems”. 

 

You will now see how to use your database. 

 

 

The right to error … 
 

 The first operation that you may have to do is change the labels registered precipitately with may be some typos. To change 

information, pull down the "Maintenance" menu and ask the command "Modify" (Fig. 21). 
 

 For the modification of elements (Class, Appellation, Wine..."), a detailed window appears allowing you to choose the 

type of item, the corresponding words related to the type of item you choose and modify text chosen. Imagine that you have mistyped 

"Clos des Mouches". Simply reenter corrected text in the "Modification:" text box of the window and click on "Accept" (Fig. 23) 
 

 In a more radical way, if you simply want to delete a text, select the "Delete" (Elements), of the menu "Maintenance ..." 

(Fig. 21). You can, for example, delete the name "Listrac", since you have created wrong and you do not restock your cellar with 

bottles of this appellation. So select the type "Appellation" and the wording "Listrac" then click "Accept" (Fig. 24). Caution: If you 

have or have had a a bottle of "Listrac" in your wine cellar, "WINe Cellar" will refuse to delete the item. 

 
_______________________________________________________________________________________________________ 
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Fig. 21 

 
 For deleting movements, the menu to use is "Data" and the command "Delete" that you have to take to get the window 

(Fig. 25) where you have to select the characteristics of the movement to delete before validating. 

_______________________________________________________________________________________________________ 
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Fig. 22 

 
 Apart typos or spelling, it happens that you enter is a wine with the wrong vintage year or containing or name or a name 

in the wrong appellation or a appellation under the wrong category. To correct this, the window "moves" is made (Fig. 26). You 

must first choose the type of movement to perform and then select all the components of movement (or the component itself) to 

move. As a result you should select the new component before validating. By here, the visit ..." 
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Fig. 23 
 

 Fig. 24 
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Fig. 25 

 

Once your wine cellar up, you will be able to visit it. 

 

First operation: to know the full composition your wine cellar or consult a selected list. To do this, you will be able to see 

the “Reports” at your disposal. In menu reports, use the command" Standard ..." or click on the button “Standard reports” in your 

main menu. A blank window appears the first time then the last “Choice” is used. In the menu “Choice”, you will be able to choose 

the sort your wine cellar. Choose the sort No. 10 showing in order: Country, Soil, Color, Appellation, Wine, Year and Container 

(Fig. 27). 

 

The sort is done column by column from left to right, alphabetically or chronologically. The result depends on extra 

columns selected in Display menu. ”Summary” menu, allows you to display a summary with breakdowns by "Color, "Year" and 

"Appellation” (Fig. 28). To return to the main menu, click "Close." 
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Fig. 26 
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Fig. 27 

 
 Another possibility: to know the composition of your wine cellar for the 1989 vintage. You will request the command 

"Specific" in menu "reports" or click on "Specific reports". A window titled "Selection Criteria" appears and asks you to select 

items for your search. 

 

 In this example, your single criterion is 1989 vintage. In the box at the top left, click on "vintage, click the option "Value" 

(if not all vintages will be displayed) and choose 1989 in the list at the top right. If you have not bottles from 1989, choose another 

year. Then click "Add to Selection” then "Accept" (Fig. 29). 

 

 A list will appear automatically showing you how many bottles of 1989 and possibly their value (Fig. 30). 

 

 
_______________________________________________________________________________________________________ 

23



WINe Cellar User’s Guide 

 

  
Fig. 28 

 
 You can print every time your report by clicking the print menu. You can also redesign your report into a spreadsheet 

from a text file that you create by clicking the menu "Export". 
 

To know when to consume, with the command "To drink" of the menu" Reports" or button "To drink" you can access a 

selection window that asks you a date or period. By clicking on one of 6 choices and providing information where appropriate like 

the Dates and then choosing the display of unit price or total price (option "Value" ), you will see a list of similar presentation to 

"Standard reports " seen above. 
__________________________________________________________________________________________________________________________________ 
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Fig. 29 

 

 
Fig. 30 
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Fig. 31 

 

 You can read the full specifications of a wine from your wine cellar by asking the command "Browse" from menu "reports" 

or by clicking the "Browse" button of the main menu. The window in figure 29 appears. 

 If you assign a label to this wine, it will open in a preview window. For the assignment of labels, see page 26 and fig.33. 

 

In window "Browse", select the Country, Soil, Appellation, Wine, Year, Container and color. You can fill in or change the dates to 

drink at you wish. By clicking the "Close" button, you will validate the information changed or added and you return to the main 

menu. Tip: After viewing a specific report or standard, a list of consumption, a mouse click with the left button on a 

_______________________________________________________________________________________________________ 
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Fig. 32 

 
line of the list automatically opens the browse window filled with data from selected wine (fig . 31). Clicking the right mouse button 

opens a menu Popup offering among other orders "Wine Input", "Wine Output", "Browse, "History", "Cellar Book ", "Notes", 

"Print Setup "and close this menu (Fig. 32). The windows displayed will always be pre filled in with data from selected wine. 

 If you wish to change the label, double click on it to get menu of the Figure 33. 
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To assign a label to a wine (on Country, Appellation, Wine, Year) you can either click on File menu, "Labels" or double-

click on label or its location in the windows "Browse" or "Cellar Book ", for the selection window labels (fig. 33). You can scan 

labels with your scanner or search on the Internet. 

 

If you chose "History" you will get a window with the list of selected wine movements (Fig. 34). "The Book Cellar" is 

brought to you figure 35, and “Notes” window figure 36. 

 

To know what are the wines that have disappeared from your cellar, the command "Stock level zero " "of the menu "Reports 

"will bring up the same report as before (standard reports) with the same choice for sorting and click with right or left. Wines whose 

remaining amount is zero will be listed. 

 

The menu lists of Input and Output Wines will show all inputs, outputs of wine made between two dates. The commands 

"Standard Input Wine" and "Standard Output Wine" will display the window in figure 37. 

 

 If you enter a date from and a date until you will know the inputs or outputs of bottles and clicking "Accept" will display 

the report window. You can choose sort criteria in the menu "Sort". 

 

 The commands "Specific Wine input" and "Specific Wine Output" will allow you more choice of selection criteria 

through the window of the same name that will appear just after the window "Selection of Movements". The research will thus be 

a little more refined. 

 

 
Neck Labels: 
 

 List the standard inputs (Fig. 37 and 38). Click the right mouse button on the "Pop Up" menu (Figure 38). Then click the 

command "Select for Neck Labels" to get the screen in Figure 39 where you can select / deselect a row by double clicking on this 

line and change the quantity with a double click. 

 

The neck labels (example Figure 40) are printed 9 per page (3 x 3) and are then to be cut and past around the neck of the bottle. 
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Fig. 33 
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Fig. 34 
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Fig. 35 
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Fig. 36 
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 Fig. 37 

 

 Fig. 38 
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    Fig. 39        Fig. 40 
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 You have to see how to record the output of a bottle from your wine cellar. Nothing could be easier. Select the "Exit Wine" 

of the menu "Data" or click on "Exit Wine". A window similar to input entries appears. Simply select wine according to different 

criteria and, after entering the quantity and possibly changed the release date, click the Accept button (Fig. 41). You will just go 

and get it from expected location - if you indicated before - and enjoy at your convenience. 

 

 

 

 

 You can of course create as many wine cellars as you like, if you want to manage the cellar of a friend, for example. To 

access the cellar that you want to manage, simply select the command "Open" from the File menu or click the Open button, or if 

you created multiple "Accounts, click on menu "File" , "Owner" and select an "Owner". If you use the "Owners ", you will reuse 

the input constants (Categories, appellations, Titles, News, Wines, Suppliers, containers, vintages ...) 

 

 

 

If the picture shown in the center of the main menu does not suit you, you can choose another, calling the command "Picture", 

from the File menu or clicking twice on the label. A selection of images compatibles is shown. Simply choose one by clicking it 

and selecting "Open" (Fig. 42). The main menu can be resized as you need, the shape of the picture does not matter. 

 

 

The new image replaces the old in the center of the main menu (Fig. 43). If some labels have been scanned the others were 

drawn using "Paintbrush" - drawing software for Windows ® 3.x - Tricot88, 91, Ligondras, Tertre. Since Windows ® 95 

"Paintbrush" became "Paint". 
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Fig. 41 
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 Fig. 42 
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Fig. 43 
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Now why not a graphical representation of your wine cellar? 
 

 Before you can manage your cellar graphically, we have to represent your storage. So click on the File menu, "New 

Storage" to display the first window of creation (Fig. 44). 

 

 
Fig. 44 

Say you have bought 5 "boxes" stacked one above another, and that in each box you can store a first layer of 7 bottles, 

then a second of 6 bottles and a third of 7 bottles (staggered). You will therefore 3 x 5 "lines" more 4 intervals be 19 lines in total 

and 7 columns. Without forgetting to check "Staggered". You just click on “Next” to get the first draft, do not worry, you can 

reverse. 

 In this screen (Fig.45) we will have to remove the green circles too many by clicking with the left mouse button and if 

you're wrong, again click the right mouse button. Assuming the 5 "boxes" of 3 rows of 7 - 6 - 7 bottles, you get what you see in 

Figure 46. Want to see the result? Then click "Next" or if you are wrong "Back". If you clicked on Next, you will get the final 

window of the series, for validation (Fig.47). There you can click "Finish" or go back by clicking "Back". 

_______________________________________________________________________________________________________ 

39



WINe Cellar User’s Guide 

 

   
   Fig. 45        Fig. 46 
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 Fig. 47 
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Well, let us see how to use it. 

 

 To access them you must have checked the "Cellar Map" in the Options window (Fig.53). Then you can "store" your 6 

bottles when entering a “new wine” or later from a standard report or report "Wines to store" by clicking on a wine line with the 

right mouse button and by selecting "Store". You will get a first window to select the Storage (Fig. 48). Click on "Test B" for 

displaying the next window where you click on green circles (= free) for 6 bottles, and then click on "Accept" (Fig.49) 

 

 To view your storage, move bottles in storage click the menu Browse, Cellar and choose the Storage in the list (Fig 48) to 

get the window in Figure 50. By moving the mouse cursor over the bottles, you will get the name of the wine. 

 

 If you want to move a bottle between two locations of the same Storage “catch” it with the mouse and drag & drop it. Do 

not forget to do the same effectively and carefully in your cellar. 

 

 If you want to move one or more bottles between two storages, you must use the menu “Maintenance”, "Move," select 

"Storage" then the storage origin and destination, the order does not matter (Fig.51). Using the mouse, you can move your bottles 

in one direction or another and even within storage. 

 

 
 
 

 

 

 

In the series “Tips and Tricks”: 

 
 In all lists of style of Figures 27, 32 and 38 you can reverse the sort criteria of a column by clicking on the title of this 

column, as in Windows Explorer. 

 

 If you have many bottles to enter, you can speed up entry by not checking the option to manage your cellar graphically  
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and once finished typing, select it and store your bottles later through the " Standard Report "or "Wines to store" menu: click the 

right mouse button on the wine to store and on "Store " in the menu that opens. 

 

 On the other hand, the storage when entering a new wine is not mandatory and if you do not, a message asks if you want 

to do it later. However, for stunned (and others), by clicking on the menu "Reports", "Wines to store", you get a list of wines to 

store in the style of "Standard Report" where you can use the click with the right button to get the menu "Store" . If you wish to be 

informed of the existence of wine to store when leaving the software, you simply check the option "Reminder" in window 

"Options"(Fig. 53) 

 

 

 
Fig. 48 
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Fig. 49 
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Fig. 50 
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Fig. 51 
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"Preferences" menu: This menu contains the commands "Printer Setup", "Printer Adjust" (Fig.52), "Options" (Fig. 53 

to 56) and 3 commands Language: - "English" , "Spanish" and "French" for today -. If you are able, you can add more. 
 

So you can configure your printer set (define) your reports, choose options and change the language. And thanks to the 

submenu, "Backup" in "File" menu you can copy your files wherever you want (Fig. 57). 

 

 
Fig. 52 

 

 After clicking , "Start Printing " and got a page with lines numbered at the top, bottom, left and right, select in the 

corresponding lists, the limits of your reports. 

 
Options: 

 

 The "General" tab of the options (Fig. 53) allows you to specify some general settings; “Reminders” will generate display 

of any message if you still have to store wine. 
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Fig. 53 
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Fig. 54 

 

 In the "Export" tab, (fig. 54), you choose the format used for exporting the various reports, "CSV" format is for 

spreadsheets and formats "XML" and "HTML", can be opened in your Internet Browser. With the last format, "Excel", will open 

automatically, so that software must be installed on your computer. 
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Fig. 55 

 

 In the "Sort movements" tab (fig. 55), you can add a date to the lists of movements, the date on which you can sort in 

descending or ascending order. You can also reverse the sorting by clicking on header of the column "Date", when viewing in 

window. 
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 Fig. 56 

 

 When you take a bottle of the blue, you do not immediately capture the "Exit". With this option, you can print a note for 

new wine per bottle, this note, by cutting and collapsing you can roll it around the neck of the bottle with a rubber band. Leaving 

the bottle put the note hand and you can enter the exit later. 

 The second option allows you to make mandatory the presence of the Help file and the third to have or not translation 

messages. 
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Fig. 57 

 

 

 
Wines-Dishes Accordance: 
 

 Do not expect sentences such as: "With such dish you must drink such wine" (or vice versa!). So you will decide according 

to your tastes, but you can get help from the dealer or producer who sold you the wine or even find this information to some 

cookbooks. 

 

 What I am proposing is to create a accord between dish and wine. 
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On the main menu, click "Data" to get window of Figure 8. The last 3 commands interest us: 

 Dish Class 

 Dish and Recipes 

 Wines-Dish Accordance 

 

 Start by clicking on "Dish Class" to get window in Figure 58. You must enter a category of dish in the box. For example 

enter "Poultry" and save. Close, back on the menu "Data", click "Dish and Recipe" to get window in figure 59. Select the class 

"Poultry", in the first list and enter the name of the dish into the box. Use the name to the recipe. E.g. "Foie gras baked". I have not 

found a dish longer to prepare (24 hours in salt, marinated 48 hours and 15 minutes in the oven!). Clicking "Save", you will get 

directly the entry screen for recipe. This entry is optional and you can click "Cancel" to return to previous window. Select a dish 

from the list of existing dishes and the button "recipe" will become valid and you will enter or modify a recipe. 

 

. 

Fig. 58 
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 Click on "Close" to return to the "Data" menu then on "Wines-Dish Accordance" to get window of figure 60. 

In this window you will select a wine and a dish and then click "Add " to create a relationship (Accord) between the dish and the 

wine selected. You can of course, have several wines for a dish and several dishes for a wine. 

 

The purpose of this input is to consult, so on main window, click on "Browse" menu then on "Wines-Dish Accordance" to get a 

window similar to the entry where you can see the agreements previously entered. 

 

 
Fig.59 
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Fig. 60 
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Fig. 61 

 

_______________________________________________________________________________________________________ 

56



WINe Cellar User’s Guide 

 

Inventory: 

 

 From a certain size it becomes necessary to make an inventory from time to time. This allows to catch mistakes, breakage, 

loss, forgetfulness ... The easiest way is to have available a list (or several) to which you refer to numbers inventoried bottles found 

without forgetting to do it opposite: mark to inventoried bottles with either rubber band (it takes a lot) or with a marker (erasable), 

with either a piece of tape or a piece of adhesive label, etc. 

 

 You will find in menu "Reports" command "Inventory" that lets you get the window of figure 62. In this window you can 

choose sort order of printing report, possibly a selection if you do not want to do a complete inventory, whether to print certain 

columns 

 

 

 Some selections are exclusive and make therefore change the following choices. 
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Fig. 62 
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Downloads: 
 

Help Files: 

 

 
Fig. 63 

 

 Click on a link to download and install the corresponding Help File (cavexx.chm). The installation is done in the same 

directory than the software. 
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User’s Manual: 

 

 
Fig. 64 

 

PDF file is opened in your default internet navigator. DOC and DOCX are Office Files 

The A5_A4 format is designed to be double-sided (4 pages per sheet) to be bound in the A5 booklet the manual exist in three 

languages: French, English and Spanish (Castilian). 
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Software update: 
 

 
Fig. 65 

 

The details of the updates appear in the default Internet browser. Download the last version downloads a ZIP file for a later update 

of the software.With the Download and install the latest version link you will get the following screen (Figure 66) 

 

________________________________________________________________________________________________________ 

61 



WINe Cellar User’s Guide 

 

 
Fig. 66 

 

Show Details: display the latest changes. 

Update: click to start the download and installation of the update. 

Cancel Update: while downloading, you can stop the operation. 

Close: To move to the next screen without updating. 
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Languages: 

 

 
Fig. 67 

 

Select a language and click on Validate. 
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Fig. 68 

 

Click on Start, The update is automatic. 
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Back to previous software version: 
 

Click on the "Maintenance" menu and then on "Previous Version" command to get: 

 

 
Fig. 66 

 

Select a version from the list and click the button "Previous version" 
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Restore saved files 
 

 

Click the "File" menu and then the command "Restore" 

 

 
Fig. 70 

 
In the same way that we backup (Fig. 57), we can restore the data and settings. Attention: all that was entered between backup and 

restore is lost. 
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Miscellaneous (general) 

 
 Contextual menu: 

 

 
Fig. 71 

Wallpapers: 

 None Windows standard color (gray).       
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 Aqua Marine : Green         

 Light Cyan : Light blue        

 Navajo White : light orange        

 Light Salmon : Orange-red        

 

 Original image: The one provided during the development of the program and provided in the "Images" directory of the 

software. 

 

 New image: The one of your choice. To tone down the colors, I use PaintShop Pro, but it doesn't have to be. 

 

 Title colors: If the image prevents you from seeing the titles correctly, you can change their color. 

 
Proportional Enlargement: 

 From 1 to 5 from the largest to the smallest. You can click on one of the enlargements or, if the one checked is appropriate 

for you, on the small square at the top right of the form. The value is kept in the form parameters. 
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 Viewed, annotated, managed, simply close "WINe Cellar" by clicking on the button "Exit" or by calling the command 

"Exit" from the File menu. "WINe Cellar" will propose you to save your database on a disk (or elsewhere), back up, useful in case 

of "Crash" HDD, or mishandled, that can happen. 

 

 One last point before I leave you alone with "WINe Cellar", if you have a problem, a doubt, press "F1" and you will display 

the corresponding help. This help file works like any Windows Help files with hyperlinks - and was created from screenshots of 

"WINe Cellar". You can also access the help screen by the command "Index" in menu "Help". In that menu you will find commands 

"Hot Line" to contact the author for any help and the eternal "about" remembering the version, the software name and that of the 

author, and your number license with your name and address. 

 

 "Voilà", it remains to me to wish you a good tasting with this tool that was missing from the palette of the perfect 

Sommelier. 

 
 

My contact information: Mr. REY Bernard 

   22 rue de Pénide 

   33460 ARSAC 

   FRANCE 

 Phone: (33) 5 56 58 66 27 

(33) 6 82 70 20 07  

 

 e-mails :  contact@rey-bernard.fr 
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NOTES: 
 

Last Updates: 
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